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A. PHẦN ÔN TẬP 
I. LÝ THUYẾT SỐ HỌC
1. Phát biểu quy tắc bỏ dấu ngoặc? 
2.  Phát biểu qui tắc chuyển vế? 
3.  Phát biểu quy tắc :Cộng hai số nguyên cùng  dấu ,cộng hai số nguyên khác dấu ,Phép trừ số nguyên 
4. Phát biểu các quy tắc nhân hai số nguyên cùng dấu,nhân hai số nguyên khác dấu.
      II.  LÝ THUYẾT HÌNH HỌC 
1. Khi nào thì điểm M là điểm nằm giữa hai điểm A,B?
     - Trung điểm M của đoạn thẳng AB là gì?
2. Thế nào là độ dài của một đoạn thẳng?
-Thế nào là hai tia đối nhau? Trùng nhau?Vẽ hình minh hoạ cho mỗi trường hợp.
3. Vẽ : + Đoạn thẳng.          + Đường thẳng.           + Tia.
  III. BÀI TẬP  SỐ HỌC
Dạng 1 : Thực hiện phép tính :
Bài 1 : Bỏ ngoặc rồi tính :a) (27+86)+(346-27-86)        b)(42-69+127)-(42+127)
Bài 2: Tính  a.(-15)+(-40)	b.65+(-70) 	c.(-12)+60	d.(-25).(-4)
Bài 3:    Thực hiện phép tính(tính hợp lí nếu có)
a. (-5).8.(-2).3	b.125-(-75)+32-(48+32)
 ( HS KHÁ –GIỎI) 
c) 360 : { | - 17 | + [ 32 . 5 – ( 14 + 211 : 28 ) ] }
Dạng 2: Tìm x
Bài 1: Tìm số nguyên x biết:  a)x+10= -14	b)-2x=8	c)24- x= - 35
Bài 2: Tìm số nguyên x biết:  a) 3. | x | = -2016      b) ( x +4 ) +(- 136) = -20        
( HS KHÁ –GIỎI) 

c) -4x - 25  = 69          d)  x +  = (-14) + 67  
  IV. BÀI TẬP HÌNH HỌC
Bài 1:  Cho N là một điểm của đoạn thẳng AB,biết AB =8cm,NB=5cm.Tính AN
Bài 2: Trên tia Ox lấy hai điểm A,B sao cho OA=2,5 cm;OB=5cm.
a.Tính độ dài đoạn thẳng AB.
b.Điểm A có phải là trung điểm của đoạn thẳng OB không?Vì Sao?
B. BÀI MỚI: Em hãy đọc kĩ bài , trả lời câu hỏi và hoàn thành các bài tập sau mỗi bài 
Bài :  BỘI VÀ ƯỚC CỦA MỘT SỐ NGUYÊN
I/LÝ THUYẾT 
Câu 1: Cho hai số tự nhiên a, b với b ≠ 0. Khi nào thì ta nói a chia hết cho b (a b)? (xem in đậm trang 96/SGK)
Câu 2: Tìm hai bội và hai ước của 6? (xem ví dụ 2 trang 97/SGK)
Câu 3: Số 0 là bội của những số nguyên nào?
           Số 0 là ước của những số nguyên nào?
           Các số 1 và -1 là ước của những số nguyên nào? (xem phần Chú ý trang 96/SGK)
Câu 4: Nêu các tính chất bội và ước của một số nguyên? (xem phần Tính chất trang 97/SGK)
Câu 5: Tìm ba bội của – 5? Tìm các ước của – 10?
II/BÀI TẬP 
          Câu 1: Cho a, b ∈ Z và b ≠ 0. Nếu có số nguyên q sao cho a = bq thì:
A.  a là ước của b                	B.  b là ước của a
C.  a là bội của b                 	D.  Cả B, C đều đúng
           Câu 2: Các bội nguyên của 6 là:
A. -6; 6; 0; 23; -23;...       	B.  132; -132; 16;...
C. -1; 1; 6; -6;...                	D.  0; 6; -6; 12; -12; ...
         Câu 3: Tập hợp các ước nguyên của 8 là:
A.  Ư(8) = {1; -1; 2; -2; 4; -4; 8; -8}         B.  Ư(8) = {0; 1; -1; 2; -2; 4; -4; 8; -8}
C.  Ư(8) = {1; 2; 4; 8}                               D.  Ư(8) = {0; 1; 2; 4; 8}
Bài :  MỞ RỘNG KHÁI NIỆM PHÂN SỐ
        Câu 1: Nêu khái niệm phân số? (xem phần in đậm trang 4/SGK tập 2)
Vậy phân số có dạng như thế nào?  
      Câu 2: Trong các cách viết sau đây, cách viết nào cho ta phân số?
[image: ]
       Câu 3: Cho ba ví dụ về phân số. Cho biết tử và mẫu của mỗi phân số? 
           Câu 4: Các số nguyên có phải là phân số không? Vì sao?	(xem phần nhận xét trang 5/SGK tập 2).
Bài :  PHÂN SỐ BẰNG NHAU
I. Lý thuyết:
Câu 1: Nêu định nghĩa Phân số bằng nhau? (Xem phần in đậm trang 8 SGK)
Câu 2: Cho ví dụ minh họa về hai phân số bằng nhau?
II. Bài tập:
Bài 1: Các cặp  phân số sau đây có bằng nhau không ?
a) 

Bài 2: Có thể khẳng định ngay các cặp phân số sau đây không bằng nhau, tại sao ?

    
Bài 3: Tìm các số nguyên x và y biết:


Bài :  TÍNH CHẤT CƠ BẢN CỦA PHÂN SỐ 
I. Lý thuyết: Phát biểu tính chất cơ bản của Phân số? (Xem phần in đậm trang 10 SGK)
II. Bài tập
Dạng 1. ÁP DỤNG TÍNH CHẤT CƠ BẢN CỦA PHÂN  SỐ ĐỂ VIẾT CÁC PHÂN SỐ BẰNG NHAU
Phương pháp giải:	Áp dụng tính chất:
[image: \frac{a}{b} ]    =    [image: \frac{a.m}{b.m} ]    với m ∈ Z và m ≠ 0.
[image: \frac{a}{b} ]    =     [image: \frac{a:n}{b:n} ]   với n ∈ ƯC(a,b)

Bài 1. Điền số thích hợp vào chỗ trống :
Dạng 2. TÌM SỐ CHƯA BIẾT TRONG ĐẲNG THỨC CỦA HAI PHÂN SỐ
Phương pháp giải
Áp dụng tính chất cơ bản của phân số để biến đổi hai phân số đã cho thành hai phân số bằng chúng nhưng có tử (hoặc mẫu) như nhau. Khi đó, mẫu (hoặc tử) của chúng phải bằng nhau, từ đó tìm được số chưa biết.

Bài 2. Tìm số nguyên x, biết:                            
Bài  GÓC
I. Lý thuyết
1. Góc là gì? Hãy vẽ một góc, đọc tên, kí hiệu và nêu tên đỉnh, tên cạnh của góc đó?
2. Thế nào là góc bet?
3. Điểm M là điểm nằm bên trong góc xOy khi nào?
II. Bài tập
Dạng 1. VẬN DỤNG KHÁI NIỆM GÓC VÀ CÁC YẾU TỐ CỦA GÓC
Phương pháp giải: Đối chiếu với định nghĩa.
Bài 1. Điền vào chỗ trống trong các phát biểu sau :
a) Hình gồm hai tia chung gốc Ox, Oy là … . Điểm O là … .Hai tia Ox, Oy là …
b) Góc RST có đỉnh là …. , có hai cạnh là … .
c) Góc bẹt là … .
Dạng 2. ĐỌC TÊN GÓC, VIẾT KÍ HIỆU GÓC VÀ ĐẾM GÓC
Phương pháp giải: Dùng ba chữ để viết các góc : chữ ở giữa chỉ đỉnh của góc ; hai chữ hai bên cùng với chữ ở giữa là tên của hai tia chung
gốc tạo thành hai cạnh của góc. Trên ba chữ của tên góc có kí hiệu ^.
Bài 2 (Bài 7 tr. 75 SGK)
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Bài 13: Làm quen với soạn thảo văn bản
(Chọn một câu trả lời đúng nhất)
Bài 1: Để khởi động phần mềm MS Word, ta thực hiện:
A. Nháy chuột vào Start → All Programs → Microsoft Word
B. Nháy chuột phải vào biểu tượng trên màn hình nền
C. Nháy chuột trái vào biểu tượng trên màn hình nền
D. Cả A và C
Bài 2: Những ưu điểm trong soạn thảo văn bản trên máy tính là:
A. Đẹp và có nhiều kiểu chuẩn xác hơn rất nhiều so với viết tay
B. Đẹp và có nhiều cách trình bày dễ hơn so với viết tay
C. Có thể chỉnh sửa, sao chép văn bản dễ dàng
D. Tất cả ý trên
Bài 3: Soạn thảo văn bản trên máy tính thì việc đưa hình ảnh minh họa vào là:
A. Dễ dàng		B. Khó khan		C. Vô cùng khó khan	D. Không thể được
Bài 4: Để mở tệp văn bản có sẵn ta thực hiện:
A. Chọn File→ Open			B. Nháy vào biểu tượng trên thanh công cụ
C. Cả A và B				D. Chọn File→ New
Bài 5: Kết thúc phiên làm việc với Word, ta thực hiện:
A. Chọn File → Exit
B. Nháy chuột vào biểu tượng chữ x ở góc trên bên phải màn hình (thanh tiêu đề)
C. Chọn Format → Exit
D. Cả A và B
Bài 6: Muốn lưu văn bản vào đĩa, ta thực hiện:
A. Edit → Save…    B. Insert → Save…    C. File → Save…    D. Edit → Save
Bài 7: Để mở văn bản ta dùng tổ hợp phím nào dưới đây?
A. Ctrl + A    B. Ctrl + O    C. Ctrl + N    D. Ctrl + S
Bài 8: Các đối tượng chính trên màn hình làm việc của Word:
A. Dải lệnh						B. Lệnh và nhóm lệnh
C. Vùng soạn thảo, con trỏ soạn thảo		D. Cả A, B và C đều đúng
Bài 9: Muốn tạo văn bản mới, ta thực hiện:
A. Chọn File→ Open			B. Nháy vào biểu tượng trên thanh công cụ
C. Cả A và B				D. Chọn File→ New → Create
Bài 10: Tên tệp do Word tạo ra có phần mở rộng là gì?
A. .TXT   		 B. .COM    		C. .EXE   		 D. .DOC
Bài 14. Soạn thảo văn bản đơn giản 
(Chọn một câu trả lời đúng nhất)
Bài 1: Các thành phần của văn bản gồm:
A. Kí tự    B. Đoạn    C. Trang    D. tất cả đáp án trên
Bài 2: Mục nào dưới đây sắp xếp theo thứ tự đơn vị xử lí văn bản từ nhỏ đến lớn?
A. Kí tự - câu - từ - đoạn văn bản
B. Kí tự - từ - câu - đoạn văn bản
C. Từ - kí tự - câu - đoạn văn bản
D. Từ - câu - đoạn văn bản - kí tự
Bài 3: Để gõ dấu huyền, sắc, hỏi, ngã, nặng theo kiểu Telex tương ứng với những phím nào?
A. f, s, j, r, x	B. s, f, r, j, x		C. f, s, r, x, j		D. s, f, x, r, j
Bài 4: Để di chuyển con trỏ tới vị trí cần thiết, ta thực hiện:
A. Bằng cách nháy chuột vào vị trí đó
B. Bằng cách nháy chuột vào vị trí cuối dòng
C. Bằng cách nháy chuột vào vị trí đầu dòng
D. Bằng cách nháy đúp chuột vào vị trí đó
Bài 5: Chọn câu sai:
A. Khi soạn thảo văn bản trên máy tính, em phải trình bày văn bản ngay khi gõ nội dung văn bản
B. Khi gõ nội dung văn bản, máy tính tự động xuống dòng dưới khi con trỏ soạn thảo đã tới lề phải
C. Khi soạn thảo nội dung văn bản, em có thể sửa lỗi trong văn bản bất kì lúc nào em thấy cần thiết
D. Có nhiều phông chữ khác nhau dùng để hiển thị và in chữ Tiếng Việt
Bài 6: Chọn câu gõ đúng quy tắc gõ văn bản trong Word.
A. Buổi sáng, chim hót véo von.
B. Buổi sáng , chim hót véo von.
C. Buổi sáng,chim hót véo von.
D. Buổi sáng ,chim hót véo von .
Bài 7: Trong soạn thảo văn bản nhấn Enter một lần để?
A. Phân cách giữa các kí tự
B. Phân cách giữa các từ
C. Phân cách giữa các đoạn
D. Phân cách giữa các trang
Bài 8: Giữa các từ dùng mấy kí tự trống để phân cách?
A. 1    B. 2    C. 2    D. 4
Bài 9: Chọn câu trả lời đúng về con trỏ soạn thảo văn bản:
A. Có dạng chữ II in hoa hoặc hình mũi tên
B. Là một vạch đứng nhấp nháy trên màn hình
C. Cho biết vị trí xuất hiện của ký tự được gõ vào
D. Cả B và C
Bài 10: Trong các phông chữ dưới đây, phông chữ nào dùng mã Unicode?
A. VNI-Times    B. VnArial    C. VnTime    D. Time New Roman
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PHẦN A: ÔN TẬP KIẾN THỨC ĐÃ HỌC: ( Trả lời các câu hỏi sau)
I) VĂN BẢN:  BÀI HỌC ĐƯỜNG ĐỜI ĐẦU TIÊN ( Tô Hoài)
Câu 1: Tìm những chi tiết miêu tả ngoại hình, tính cách của Dế Mèn. Từ đó rút ra kết luận?
Câu 2: Tìm những chi tiết miêu tả về ngoại hình, tính cách của Dế Choắt. Từ đó rút ra kết luận ?
Câu 3: Bài học đường đời đầu tiên mà Dế Mèn nhận được là gì ?
II) VĂN BẢN:  SÔNG NƯỚC CÀ MAU (Đoàn Giỏi)
Câu 1: Tìm những chi tiết thể hiện sự rộng lớn, hùng vĩ của dòng sông Năm Căn
Câu 2: Những nét đặc sắc của chợ Năm Căn 
Câu 3: Viết một đoạn văn(5-7 dòng) trình bày cảm nhận của em về vùng Cà Mau qua bài Sông Nước Cà Mau đã học.
III) TIẾNG VIỆT: 
BÀI : PHÓ TỪ
Câu 1: Tìm các phó từ và nêu ý nghĩ của phó từ trong đoạn văn  sau“ Bởi tôi… vuốt râu”  ( Bài học đường đời đầu tiên)  
IV) TẬP LÀM VĂN: (Chuẩn bị cho bài viết ở nhà) Các em viết thành bài văn hoàn chỉnh cho các đề sau:
ĐỀ 1: TẢ CƠN MƯA RÀO MÙA HẠ 
Gợi ý dàn ý:
+ Mở bài: Giới thiệu cơn mưa rào mùa hạ
+Thân bài:
· Tả cảnh trước cơn mưa ( Bầu trời, cảnh vật, dấu hiệu cơn mưa)
· Tả cảnh cơn mưa (Bầu trời, cảnh vật,con vật, cơn mưa)
· Tả cảnh sau cơn mưa (Quang cảnh, con vật…)
+ Kết bài: Cảm nhận của em về cơn mưa.
Đề 2: TẢ SÂN TRƯỜNG EM GIỜ RA CHƠI
Gợi ý:
+ Mở bài: Giới thiệu giờ ra chơi
+ Thân bài: 
- Cảnh sân trường trước giờ ra chơi (Không gian, cảnh vật, …)
- Cảnh sân trường giờ ra chơi (Không gian, cảnh vật, học sinh và các hoạt động khác…)
- Cảnh sân trường sau giờ ra chơi
+ Kết bài: Suy nghĩ, cảm nhận của em …
PHẦN B : SOẠN BÀI MỚI
I) VĂN BẢN: VƯỢT THÁC (Võ Quảng)
Câu 1: Cảnh dòng sông và cảnh hai bên bờ được tác giả miêu tả như thế nào ?
Câu 2: Cảnh con thuyền vượt thác được miêu tả ra sao? Tìm những chi tiết miêu tả ngoại hình, hành động của dượng Hương Thư ?
Câu 3: Cảm nhận của em về thiên nhiên và con người lao động qua văn bản?
II) VĂN BẢN: BỨC TRANH CỦA EM GÁI TÔI (Tạ Duy Anh)
Câu 1: Kể tóm tắt lại truyện
Câu 2: Tìm những chi tiết thể hiện diễn biến tâm trạng của nhân vật người anh?
Gợi ý: Qua 3 thời điểm:
· Khi thấy em gái chế thuốc vẽ
· Khi phát hiện tài năng của em gái
· Khi đứng trước bức tranh em gái vẽ mình
Câu 3: Cảm nhận của em về nhân vật Kiều Phương ?
   Gợi ý: Vẻ đẹp, tài năng, phẩm chất …..
III) TIẾNG VỆT
   BÀI:  SO SÁNH ( SGK/ 24 )
 Câu 1: Đọc ví dụ 1 ( SGK/24)
· Tìm các phép so sánh trong Ví dụ 1/SGK/ 24
· Trong các phép so sánh, những sự vật, sự vệc nào được so sánh với nhau ? Vì sao ?
· Từ đó, hãy điền vào mô hình cấu tạo phép so sánh ( Mục II – SGK/ 24)
 Câu 2: Tìm thêm một vài phép so sánh khác mà em biết?
· BÀI: SO SÁNH ( tiếp) (SGK/41)
   Câu 1: Đọc Ví dụ 1 (SGK/41)
· Tìm phép so sánh
· Xác định các kiểu so sánh 
III) TẬP LÀM VĂN
     Bài “ Quan sát, tưởng tượng, so sánh và nhận xét trong văn miêu tả”
Đọc ví dụ : các đoạn văn 1,2,3 trả lời câu hỏi
Câu 1: Mỗi đoạn văn giúp em hình dung đặc điểm nổi bật gì của sự vật và phong cảnh được miêu tả ?
Câu 2 : Những từ ngữ, hình ảnh làm nổi bật đặc điểm sự vật và cảnh vật trong mỗi đoạn văn?
Câu 3: Tìm những câu văn sử dụng yếu tố so sánh, liên tưởng trong các đoạn văn?
Bài : Luyện nói : Quan sát, tưởng tượng, so sánh và nhận xét trong văn miêu tả”
+ Lập dàn ý cho các đề luyện nói sau:
Đề 1: Tả một đêm trăng đẹp nơi em ở .
Gợi ý: 
· Nó là một đêm trăng như thế nào ?
· Đêm trăng đó có gì đặc sắc, tiêu biểu ?
· Để miêu tả một đêm trăng đẹp, em sử dung những phép so sánh nào ?
Đề 2:  Tả cảnh một buổi sáng trên biển
Gợi ý:  
· Cảnh biển vào buổi sáng có vẻ đẹp gì ?
( Bầu trời , mặt biển, mặt trời, sóng biển, bãi cát …)
· Những hình ảnh so sánh các em sử dụng ./.
(Lưu ý : Các em soạn bài đầy đủ vào vở soạn, GV bộ môn sẽ thu vở và chấm lấy điểm sau khi các em có lịch học lại).



NỘI DUNG ÔN TẬP CÔNG DÂN 6
I. Củng cố kiến thức
1.Theo Công ước Liên hợp quốc, trẻ em có những quyền nào?
2. Em hãy nêu 3 hành vi thực hiện đúng quyền trẻ em và 3 hành vi vi phạm quyền trẻ em mà em biết?
3. Em sẽ xử sự như thế nào nếu gặp phải những tình huống sau đây?
a) Em thấy nhà bên cạnh, bố mẹ luôn đánh đập con cái.
b) Em thấy có một vài bạn trong lớp tụ tập hút thuốc lá.
c) Em thấy một số bạn nơi em sống chưa biết chữ.
4. Lên cấp 2, Hoa đòi bố mẹ mua laptop riêng để phục vụ cho việc học tập. Bố mẹ bảo rằng chưa thật sự cần thiết, nếu cần làm bài tập  có sự hỗ trợ của công nghệ thông tin thì có thể sử dụng chung máy tính với bố mẹ. Hoa oán trách bố mẹ cho rằng đã không tôn trọng quyền phát triển của mình? Theo em, trong trường hợp này ai đúng ai sai?Nếu em là Hoa, em sẽ ứng xử thế nào?
II. Soạn bài mới
1. Em hiểu thế nào là công dân của một nước?
2. Căn cứ vào đâu để xác định người đó là công dân nước nào?
3. Theo em, học sinh cần rèn luyện những gì để trở thành một công dân tốt?

HƯỚNG DẪN ÔN TẬP  MÔN THỂ DỤC, ÂM NHẠC, MỸ THUẬT
1. Ôn tập bài thể dục buổi sáng, thể dục giữa giờ hằng ngày để rèn luyện thân thể.
2. Thư giãn bằng cách hát lại những bài hát đã học.
3. Hãy vẽ một bức tranh theo chủ đề tự chọn.

NỘI DUNG ÔN TẬP VÀ SOẠN BÀI MÔN CÔNG NGHỆ 6
A. NỘI DUNG ÔN TẬP - Học sinh trả lời các câu hỏi Bài 15.  Cơ sở của ăn uống hợp lí
Câu 1 : Trình bày nguồn cung cấp và chức năng dinh dưỡng  của chất đạm, chất đường bột, chất béo, sinh tố ( vitamin) ?
Câu 2: Nêu nhu cầu dinh dưỡng của cơ thể về chất đạm ,chất béo, chất đường bột ?
B. BÀI  MỚI - Học sinh đọc kĩ các bài sau
 - Vệ sinh an toàn thực phẩm 
           - Bảo quản chất dinh dưỡng trong chế biến món ăn 
Và nêu được các biện pháp tránh ngộ độc thức ăn, các cách bảo quản dinh dưỡng trong chế biến món ăn.

HƯỚNG DẪN TỰ HỌC TẠI NHÀ MÔN LỊCH SỬ 6
I: PHẦN ÔN TẬP
Bài 17:  CUỘC KHỞI NGHĨA HAI BÀ TRƯNG (NĂM 40)
Câu 1. Nêu những nét chính về tình hình Âu Lạc từ thế kỉ II TCN đến thế kỉ I?
Câu  2. Trình bày chính sách thống trị của phong kiến phương Bắc?
Câu 3. Nêu diễn biến chính của cuộc khởi nghĩa Hai Bà Trưng?
II: PHẦN TỰ HỌC CÓ HƯỚNG DẪN
Tiết 20:  Bài 18 :    TRƯNG VƯƠNG VÀ CUỘC KHÁNG CHIẾN 
               CHỐNG QUÂN XÂM LƯỢC HÁN ( sgk trang 50 đến 52)
Mục 1. Hai Bà Trưng đã làm gì sau khi giành lại được độc lập?
- Trưng Trắc được suy tôn làm vua (Trưng Vương), đóng đô ở Mê Linh.
- Những việc làm của chính quyền Trưng Vương:
+ Phong tước cho những người có công, lập lại chính quyền.
+ Trao quyền cai quản cho các Lạc tướng.
+ Xá thuế cho dân.
+ Bãi bỏ các thứ lao dịch nặng nề.
Câu 1: Hai Bà Trưng đã làm gì sau khi giành lại được độc lập?
Câu 2: Tác dụng và ý nghĩa của những việc làm đó?
Mục 2. Cuộc kháng chiến chống quân xâm lược Hán (42 – 43) đã diễn ra như thế nào?
- Tháng 4 năm 42, quân Hán tấn công Hợp Phố, quân ta chống trả rồi rút lui.
- Sau khi chiếm Hợp Phố, Mã Viện chia quân thành 2 đạo thuỷ, bộ tiến vào nước ta. 
- Hai Bà Trưng cho quân nghênh chiến ở Lãng Bạc. Cuộc chiến đấu diễn ra quyết liệt.
-Thế giặc mạnh, quân ta lui về giữ Cổ Loa và Mê Linh.
-Mã Viện đuổi theo, Hai Bà Trưng chiến đấu oanh liệt và hi sinh ở Cấm Khê.
Cuối 3-43 Hai bà hi sinh ở Cấm Khê.
*Ý nghĩa:
Tiêu biểu cho ý chí quật cường bất khuất của dân tộc ta.
1.Cuộc kháng chiến chống quân xâm lược Hán diễn ra như thế nào? Nêu ý nghĩa của cuộc kháng chiến?
2. Vì sao ở khắp nơi trên đất nước ta , nhân dân đều lập đền thờ Hai Bà Trưng?
Tiết 21, Bài 19:   TỪ SAU TRƯNG VƯƠNG ĐẾN TRƯỚC LÝ NAM ĐẾ
                           (Giữa thế kỷ I – Giữa thế kỷ VI) 
Mục 1. Chế độ cai trị của các triều đại phong kiến  phương   Bắc   đối  với nước ta từ thế kỷ I đến giữa thế kỉ VI.
- Sau khi đàn áp được cuộckhởi nghĩa hai bà Trưng  nhà Hán   vẫn   giữ   nguyên   ChâuGiao.
- Đầu thế kỷ III nhà Ngô tách Châu Giao thành Quảng Châu(thuộc TQ cũ), Giao Châu (ÂuLạc cũ).
- Bộ máy cai trị: Đưa ngườiHán sang làm huyện lệnh ( caiquản huyện).
-Nhân   dân   Giao   Châu   chịunhiều   thứ   thuế,   lao   dịch   và cống nạp ( sản phẩm quí...thợ khéo).
- Chúng tăng cường đưa người Hán sang Giao Châu, bắt nhân dân ta học tiếng Hán, theo luậ tpháp   và  phong  tục tập quán người Hán.
Câu 1. Trình bày chính sách cai trị của phong kiến phương Bắc đối với nước ta từ giữa thế kỉ I đến giữa thế kỉ VI?
Câu 2. Em có nhận xét gì về chính sách bóc lột của bọn đô hộ?
Câu 3. Vì sao nhà Hán tiếp tục thi hành chủ trương đưa người Hán sang ở nước ta?
Mục 2.  Tình   hình  kinh tế của nước ta từ thế kỷ I đến thế kỷ VI có gì thay đổi?
- Nhà Hán nắm độc quyền về sắt nhưng nghề rèn sắt ở Giao Châu vẫn phát triển.
- Về nông nghiệp: Từ thế kỷ I dùng trâu, bò cày bừa, có đê phòng lụt, trồng 2 vụ lúa trên năm, trồng cây ăn quả...với kỹ thuật cao, sáng tạo.
- Về thủ công nghiệp- thương nghiệp: Nghề sắt, gốm phát triển nhiều  chủng   loại:   bát,   đĩa,gạch...Nghề dệt phát triển: vải bông, vải gai...dùng tơ tre dệt thành vải “ vải Giao Chỉ”.- Chính quyền đô hộ giữ độc quyền ngoại thương.
Câu 1: Trình bày những biểu hiện thay đổi trong kinh tế nước ta từ giữa thế kỉ I đến giữa thế kỉ VI.
Câu 2: Vì sao nhà Hán giữ độc quyền về sắt?
Tiết 22, Bài 20: TỪ SAU TRƯNG VƯƠNG ĐẾN TRƯỚC LÝ NAM ĐẾ 
                              (Giữa thế kỷ I – Giữa thế kỷ VI) (tiếp theo)
SGK TRANG 55 đến 57
Mục 3. Những chuyển biến về xã hội, văn hoá nước ta ở các thế kỷ I - VI
a. Xã hội:
Xã hội thời Văn Lang- Âu Lạc đã phân hóa thành 3 tầng lớp: quý tộc, nông dân công xã và nô tì.
Từ khi bị phong kiến phương Bắc đô hộ, xã hội tiếp tục phân hóa:
+Tầng lớp thống trị: bọn quan lại  người Hán,hào trưởng người Việt.
+ Nông dân công xã: Nông dân công xã và nông dân lệ thuộc.
b. Văn hoá:
- Chính quyền đô hộ mở trường học dạy chữ Hán tại các quận.
- Truyền vào nước ta Nho giáo, Đạo giáo, Phật giáo và những luật lệ, phong tục Hán của người Hán vào nước ta.
 Nhân dân ta vẫn giữ được phong tục tập quán và tiếng nói của tổ tiên.
Câu 1: Vẽ sơ đồ so sánh sự phân hóa xã hội nước ta thời kì bị đô hộ(ở các thế kỉ I-VI) vớ thời Văn Lang – Âu Lạc. Nhận xét về sự phân hóa đó?
Câu 2: Những nét mới về văn hóa nước ta ở các thế kỉ I-VI? Vì sao người Việt vẫn giữ được phong tục tập quán của tổ tiên? 
4. Cuộc khởi nghĩa Bà Triệu (năm 248)
a. Nguyên nhân:
- Do chính sách thống trị tàn bạo của nhà Ngô.
- Nhân dân không cam chịu bị áp bức, bóc lột nặng nề
b. Diễn biến:
- Năm 248 cuộc khởi nghĩa bùng nổ ở Phú Điền (Hậu Lộc – Thanh Hoá).
- Cuộc khởi nghĩa lan rộng khắp Giao Châu.
- Vua Ngô sai Lục Dận đem 6000 quân đàn áp. Bà Triệu hi sinh trên núi Tùng (Thanh Hoá)
c.Ý nghĩa: 
 -Khẳng định ý chí bất khuất giành lại độc lập dân tộc.
Trình bày nguyên nhân, diễn biến,ý nghĩa của cuộc khởi nghĩa Bà Triệu?
Tiết 23: LÀM BÀI TẬP LỊCH SỬ
Câu1:
Quan sát sơ đồ sau. Em hãy điền vào chỗ trống cho biết nhà Hán sắp đặt bộ máy cai trị ở châu Giao như thế nào?

	Châu
	
	Quận
	
	Huyện


Đứng đầu là……….......  	Đứng đầu là………...........  	 Đứng đầu là……….......... 
Câu 2: 
Những nơi nào đẫ diễn ra cuộc khởi nghĩa của Hai Bà Trưng (sắp theo tứ tự)
a. Mê Linh	→	Hát Môn	→	Chu Diên		
b. Hát Môn 	→	Long Biên 	→	Cổ Loa
c. Mê Linh 	→	Cổ Loa 	→	Long Biên	
d. Hát Môn 	→	Mê Linh 	→	Cổ Loa 	→	Luy Lâu
Câu 3:Điền vào  bảng tóm tắt tình hình kinh tế nước ta thế kỉ I – VI.
	Nội dung
	Chính sách cai trị của phong kiến phương Bắc
	Tình hình kinh tế nước ta

	Nông nghiệp
	.................................................................................................................................................................................................................................
	.................................................................................................................................................................................... .............................................

	Thủ công nghiệp và thương nghiệp
	................................................................................................................................................................................... ..........................................................................................
	.................................................................................................................................................................................... ..........................................................................................

	Nhận xét
	.................................................................................................................................................................................................................................................................................................................................................................................... 


Câu 4:Điền vào bảng tóm tắt diễn biến cuộc khởi nghĩa Bà Triệu 248.
	Thời gian
	Địa điểm  xảy ra cuộc khởi nghĩa
	Diễn biến
	Kết quả

	.................................................................................................. ..........................................
	................................................................................................................................................... ...............................................................
	..................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
	..................................................................................................................................................................................................................................................................................................

	Ý nghĩa
	....................................................................................................................................................................................................................................................................................................................................................................................................................................................................................







HƯỚNG DẪN TỰ HỌC Ở NHÀ MÔN ĐIA LÍ 6
Bài 15-Tiết 19. CÁC MỎ KHOÁNG SẢN
1. Khoáng sản là gì? Trình bày sự phân loại khoáng sản theo công dụng.
2. Qúa trình hình thành mỏ nội sinh và mỏ ngoại sinh như thế nào ?
Bài 16 – Tiết 20.  THỰC HÀNH	
 ĐỌC BẢN ĐỒ (HOẶC LƯỢC ĐỒ) ĐỊA HÌNH TỈ LỆ LỚN.
Câu 1: Đường đồng mức là những đường như thế nào ?.Tại sao dựa vào những đường đồng mức trên bản đồ,chúng ta có thể biết được hình dạng địa hình?
Câu 2: - Xác định trên lược đồ h44 hướng từ núi A1 đến đỉnh núi A2 ?
           - Sự chênh lệch độ cao của 2 đường đông mức là bao nhiêu  ?
            - Dựa vào đường đồng mức tìm độ cao các đỉnh A1 ,A2 điểm B1,B2,B3.
BÀI 17 –Tiết 21:  LỚP VỎ KHÍ 
1.Thành phần của không khí:
 - Gồm các khí:Nito chiếm 78%, ôxi 21% .các khí khác 1%
- Lượng hơi nước nhỏ nhưng là nguồn gốc sinh ra mây , mưa ,sương mù.
CH: Không khí bao gồm những thành phần nào? Mỗi thành phần chiếm tỉ lệ bao nhiêu %?
2. CẤU TẠO CỦA LỚP VỎ KHÍ (KHÍ QUYỂN)
- Gồm có 3 tầng : Tầng đối lưu,tầng bình lưu và tầng cao cùa khí quyển.
-Tầng đói lưu có độ day từ 0- 16 km luôn có sự chuyển động của không khí theo chiều thẳng đứng, là nơi sinh ra các hiện tượng: Mây ,mưa ,sấm chớp…có ảnh hưởng lớn của các sinh vật trên Trái Đất
Trung bình cứ lên cao 100m nhiệt độ giảm 0,6ºC.
CH: Lớp vỏ khí gồm những tầng nào? Vị trí của mỗi tầng?
CH: Đặc điểm của tầng đối lưu,vai trò ý nghĩa của nó đối sự sống trên bề mặt Trái Đất ?
3. CÁC KHỐI KHÍ:
-Căn cứ vào nhiệt độ , người ta chia ra :Khối khí nóng, khối khí lạnh.
-Căn cứ vào mặt tiếp xúc bên dưới là đại dương hay đất liền, người ta chia ra khối khí đâị dương hay đất liền.
CH: Khối khí nóng và khối khí lạnh hình thành ở đâu? Nêu tính chất mỗi loại?
CH: Khối khí đại dương và khối khí lục địa hình thành ở đâu ? Nêu tính chất mỗi loại?
BÀI 18- TIẾT 22 THỜI TIẾT ,KHÍ HẬU VÀ NHIỆT ĐỘ KHÔNG KHÍ
1. THỜI TIẾT VÀ KHÍ HẬU.
a.Thời tiết: Là sự biểu hiện các hiện tượng khí tượng ở một địa phương trong thời gian ngắn.
b.Khí hậu: Là sự lặp đi lặp lại của tình hình thời tiết ở một địa phương trong thời gian dài và trở thành quy luât
CH.Thời tiết và khí hậu khác nhau ở điểm nào?

2 NHIỆT ĐỘ KHÔNG KHÍ VÀ CÁCH ĐO NHIỆT ĐỘ KHÔNG KHÍ
a.Nhiệt độ không khí: Độ nóng lạnh của không khí gọi là nhiệt độ không khí’
b. Cách đo nhiệt độ không khí:
-Dùng nhiệt kế để đo nhiệt độ không khí
-Cách tính nhiệt độ ttrung bình ngày = Tổng nhiệt độ trung bình các lần đo  chia cho số lần đo.
Câu hỏi;  Giả  sử có một ngày ở Hà Nội ,người ta đo nhiệt độ lúc 1 giờ được 20 ºC ,lúc 7 giờ được 24ºC ,lúc 13 giờ được  28ºC, và lúc 19 giờ được 24ºC. Hỏi nhiệt đô trung bình ngày hôm đó là bao nhiêu ? Em hãy nêu cách tính.? 
C. Sự thay đổi nhiệt độ của không khí:
-Nhiệt độ không khí thay đổi tùy theo độ gần hay xa biển
-Nhiệt độ không khí thay đổi tùy theo độ cao.Càng lên cao nhiệt độ không khí càng giảm
-Nhiệt độ không khí thay đổi theo vĩ độ.

HƯỚNG DẪN ÔN TẬP SINH HỌC 6
I. ÔN TẬP KIẾN THỨC CŨ
Từ tiết 37 đến tiết 39
- Tiết 37: Bài 30: THỤ PHẤN (tt)
Câu 1: Hoa thụ phấn nhờ gió có những đặc điểm gì?
Câu 2:  Con người chủ động thụ phấn cho hoa nhằm mục đích gì?
- Tiết 38: BÀI 31:  THỤ TINH, KẾT HẠT VÀ TẠO QUẢ
Câu 1: Thụ tinh là gì?
- Tiết 39: BÀI 32: CÁC LOẠI QUẢ
Câu 1: Phân biệt quả khô và quả thịt?
Cho 2 ví dụ quả khô nẻ, 2 ví dụ quả khô không nẻ, 2 ví dụ quả mọng, 2 ví dụ quả hạch.
II. CHUẨN BỊ BÀI MỚI
Từ tiết 40 đến tiết 43
- Tiết 40: BÀI 33: HẠT VÀ CÁC BỘ PHẬN CỦA HẠT
Câu 1: Hạt gồm những bộ phận nào?
Câu 2: Hạt hai lá mầm khác hạt một lá mầm ở điểm nào?
- Tiết 41: BÀI 34: PHÁT TÁN CỦA QUẢ VÀ HẠT
Câu 1: Có mấy cách phát tán của quả và hạt? Đó là những cách nào?
- Tiết 42: BÀI 35: NHỮNG ĐIỀU KIỆN CẦN CHO HẠT NẢY MẦM
Câu 1: Hạt nảy mầm cần những điều kiện nào?
- Tiết 43: BÀI 36: TỔNG KẾT CÂY CÓ HOA
Câu 1: Kể tên những cơ quan của cây có hoa?
Câu 2: Các cơ quan sinh dưỡng có cấu tạo như thế nào? Chúng có chức năng gì?
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HƯỚNG DẪN ÔN TẬP VÀ SOẠN BÀI HỌC MÔN VẬT LÝ LỚP 6
Phần I: Các bài đã học : Đòn bẩy
A. Câu hỏi:
1. Nêu cấu tạo của đòn bẩy?
2. Kể tên một vài ứng dụng đòn bẩy trong cuộc sống?
B. Bài tập
1. Chọn từ thích hợp điền vào chỗ trống:
a) Đòn bẩy luôn có…….và có………tác dụng vào nó.
b) Khi khoảng cách từ điểm tựa tới điểm tác dụng của người lớn hơn khoảng cách từ điểm tựa tới điểm tác dụng của vật cần nâng thì dùng đòn bẩy này được lợi………..
2. Một đòn bẩy có OO1> OO2 để đòn bẩy cân bằng thì hai lực F1, F2 (đặt vào 2 điểm O1, O2) lực nào có cường độ mạnh hơn.
3. Làm các bài tập trong SBT.
Phần II: Nội dung bài mới
Bài 16: Ròng rọc
A. Câu hỏi
1. Có mấy loại ròng rọc? Cho 2 ví dụ ứng dụng của mỗi loại?
2. Dùng ròng rọc có lợi ích gì? Làm thế nào để sử dụng ròng rọc vừa có lợi về hướng và vừa có lợi về độ lớn của lực?
B. Bài tập
1. Ròng rọc cố định được sử dụng trong công việc nào dưới đây?
A. Đưa xe máy lên bậc dốc ở cửa để vào trong nhà.
B. Dịch chuyển một tảng đá sang bên cạnh.
C. Đứng trên cao dùng lực kéo lên để đưa vật liệu xây dựng từ dưới lên.
D. Đứng dưới đất dùng lực kéo xuống để đưa vật liệu xây dựng lên cao.
2. Làm các bài tập trong SBT.
Bài 17: Ôn tập chương I: Cơ học
A. Câu hỏi: Trả lời các câu hỏi trong phần I. Ôn tập trong sgk/trang 53.
B. Bài tập: Làm tất cả các bài tập trong phần II. Vận dụng, phần III trong sgk/trang 54,55.
Bài 18: Sự nở vì nhiệt của chất rắn
A. Câu hỏi: 
1. Nêu kết luận về sự nở vì nhiệt của chất rắn?
2. Các chất rắn khác nhau sự nở vì nhiệt của chúng như thế nào?
B. Bài tập: 
1. Làm tất cả các bài tập trong phần vận dụng SGK, SBT.
2. Tại sao người ta thường bỏ cốc vào nồi luộc sôi trong một thời gian rồi mới đem ra dùng?
3. Vì sao vào mùa hè dây điện thoại thường bị võng xuống còn vào mùa đông lại không có hiện tượng đó ?
Bài 19: Sự nở vì nhiệt của chất lỏng
A. Câu hỏi: 
1. Nêu kết luận về sự nở vì nhiệt của chất lỏng?
2. Các chất lỏng khác nhau sự nở vì nhiệt của chúng như thế nào?
Chú ý: Sự nở vì nhiệt đặc biệt của nước (Đọc phần có thể em chưa biết)
B. Bài tập: 
1. Làm tất cả các bài tập trong phần vận dụng SGK, SBT.
2. Hai chất lỏng khác nhau, có thể tích bằng nhau, được đựng trong hai bình thủy tinh giống nhau. Khi đun hai bình đó lên cùng một nhiệt độ thì các mực chất lỏng trong hai bình đó như thế nào? Tại sao?
3. Một bình cầu chứa nước như hình vẽ. 
a) Muốn cho mực nước dâng lên, ta phải làm như thế nào? Giải thích?
b) Nếu nhúng bình cầu này vào trong nước lạnh, hiện tượng gì xảy ra? Lúc này nước trong bình có thể tích thay đổi như thế nào?
Bài 20: Sự nở vì nhiệt của chất khí
A. Câu hỏi: 
1. Nêu kết luận về sự nở vì nhiệt của chất lỏng?
2. Các chất khí khác nhau sự nở vì nhiệt của chúng như thế nào?
3. So sánh sự nở vì nhiệt các chất rắn, lỏng, khí?
B. Bài tập: 
1. Làm tất cả các bài tập trong phần vận dụng SGK, SBT.
2. Tại sao vào mùa hè ta không nên bơm lốp xe quá căng?
3. Tại sao khi quả bóng bàn bị bẹp, nhúng vào nước nóng nó lại phồng lên ?









                                       REVISION – ENGLISH 6
A. UNIT 7  - TELEVISION
I/ Choose the best answer to complete the following sentences or do as directed:
1. Disney Channel is one of the most		channels 		 children .
	A.good - for	B.exciting - of	C.popular - to	D.popular - for
2.	My family enjoys watching game shows		they are very exciting and interesting.
	A.because	B.so	C.but	D.and
3.	VTV1 is a		television channel in Viet Nam, and it attracts millions of TV viewers in Viet Nam.
	A.wide	B.local	C.international	D.national
4.	"What is your		 . TV programme?" - "It's cartoons"
	A.good	B.favourite	C.best	D.like
5.	"		do you like the Modern English programme? " - "Because it helps me with my English."
	A.What	B.How	C.When	D.Why
6.	My brother wants to become a		to tell TV viewers what the weather is like.
	A.newsreader	B.actor	C.weatherman	D.producer
7.	TV		can join in some game shows through telephone or by mail.
	A.people	B.weathermen	C.newsreaders	D.viewers
8. My brother likes watching TV ___________ I like going out with my friends.
	A.and	B.but	C.or	D.so
9. I want to work in television industry, ___________ I am working hard.
    A.because	B.although	C.so	D.and
10. They cancelled their picnic ___________ the weather was bad.
    A.because	B.when	C.but	D.or
11. ___________ the programme is late, we will wait to watch it.
    A.Because	B.Although	C.When	D.So
12.You can watch Harry Potter on TV ___________ you can read it.
    A.so	B.when	C.but	D.or
13. Millions of children around the world enjoy the cartoon because it can both		and 		a young audience.
	A.entertain - education	B.entertainment – education
	C.entertainment - educate	D.entertain - educate
14.	Many people with different skills work hard		quality programmes for television.
	A.produce	B.to produce	C.producing	D.to producing
15.	If you want to know what the weather is like tomorrow, watch the		.
	A.weather forecast	 B.music show	C.game show	D.quiz show
16.	"		is that TV programme directed by?" - "By a famous Vietnamese director."
	A.What	B.Where	C.When	D.Who
17.	Find the word which has a different sound in the underlined part. 
	A.thirty	B.theme	C.both	D.them
18.	Find the word which has a different sound in the underlined part. 
	A.brother	B.weather	C.through	D.than
19.	Find the word which has a different sound in the underlined part. 
	A.earth	B.feather	C.theater	D.thanks
20.	Find the word which has a different sound in the underlined part. 
	A.clumsy	B.cute	C.but	D just
21. ____________ do you often go to the gym ? – on Sundays  
	A.Who 	B.What 	C.When	D.Why
22. In ___________, there is no TV on Thursdays.
	A.Finland	B.Iceland	C.Britain	D.Japan
23. Pokemon cartoons are made in _______________.
	A.England	B.Finland	C.Japan	D.America
24. VTV1 attracts millions _______ viewers because it offers different interesting programmes.
	A.in	B.on	C.at	D.of
25. You’d like to watch events in real life, so you should see a ___________.
	A.cartoon	B.documentary	C.comedy	D.game show
26. The most popular TV _________ in Viet Nam are VTV1 and VTV3.
	A.channels	B.programmes	C.shows	D.televisions
27. A(n) _________ programme can always teach children something.
	A.education	B.educate	C. educational	D.entertaining
28. We use a _________ to change the channels from a distance.
	A. remote control	B.TV schedule	C.newspaper	D.volume button
29. My mother’s favourite _________ is Xuan Bac.
	A.comedian	B.comedy	C.newsreader	D.weatherman
30. ________ are you playing the video game? – For an hour.
	A.How often	B.How long	C.When	D. How many

II/ Give the correct tense of the verbs in bracket:
1. Mrs. Mai usually____________(finish) her work at 5 p.m.
2. A-    Where _______(be) your children?
          B-     They_______________(watch) TV in the sitting room.
    3. In England the sun ____________ (not shine) every day.
    4.There__________(be) a lamp, a computer and some books on my desk.
5.You must __________(wash) your hands before meals.
6. I promise I (return)______________to school on time.
7. If it rains, he (stay)____________at home.
8. _______You (take)__________ me to the zoo this weekend?
9. I think he (not come)_______________back his hometown.
10. Sit down! A strange dog (run)____________ to you.
11. My mom often (buy)_____________ meat from the butcher’s.
12. My brothers (not/ drink)_______________ coffee at the moment.
13. Look! Those people (climb)______________ the mountain so fast.
14. That girl (cry)_____________ loudly in the party now.
15. Shh! The boss (come)  _____________________.
16. __________you usually (go) ____________ away for Christmas?
17. Mrs. Nga usually_____________(watch) TV after dinner.
18. You should_____________(help) old people.
19. My sister ( do )____________ her homework tonight.
20.He ( not like )__________ watching cartoons.
III/ READING
A/ Reading the passage, and answer the questions. 
	Today, there is a TV set in nearly every home. People watch television every day, and some people watch it from morning until night. Americans watch television about 35 hours a week. But is television good or bad for you? People have different answers. Some say that there is a lot of violence on TV today, the programs are terrible and people don't get any exercise because they only sit and watch TV. Others think that TV programs bring news from around the world, help you learn many useful things, especially children. Thanks lo television, people learn about life in other countries, and it helps people relax after a long day of hard work. 
1.	Is television very popular nowadays? Why? 
		
2.	How many hours do Americans watch TV a day? 
		
3. 	Why don't some people like watching television? 
		
4.	What does television bring to you? 
		
5. 	What do you learn from television? 
		
IV/ WRITING
* Do as directed:
1. I/ like/ because/ boring/ not/ show/ is/ do/ this/ it. ( Put the words in the correct order )
_______________________________________________________________________.
2. this/ Millions/ around/ enjoy/ children/ of/ world/ cartoon/ the. ( Put the words in the correct order ) _______________________________________________________________.
3. We often read books and play sports in our free time. ( Make the question with the underlined words )___________________________________________________________________?
4. This programme is on the Disney Channel. ( Make the question with the underlined words )
___________________________________________________________________?
5. I watch TV one or two hours a day. ( Make the question with the underlined words )
___________________________________________________________________?
B. UNIT 8   - SPORTS AND GAMES
I/ VOCABULARY
	- archery /ˈɑr·tʃə·ri/ (n): bắn cung
	- ice-skating /ˈɑɪs ˌskeɪt/ (n): trượt băng

	- athlete /ˈæθˌlit/ (n): vận động viên
	- last /læst/ (v): kéo dài

	- athletics /æθˈlet̬·ɪks/ (n): điền kinh
	- marathon race /ˈmær·əˌθɑn reɪs/ (n): chạy ma-ra-tông

	- boat /boʊt/ (n): con thuyền
	- racket /ˈræk·ɪt/ (n): cái vợt (cầu lông...)

	- career /kəˈrɪər/ (n): nghề nghiệp, sự nghiệp
	- regard /rɪˈgɑrd/ (v): coi là

	- congratulations /kənˌɡrætʃ·əˈleɪ·ʃənz/ (n): xin chúc mừng
	- ring /rɪŋ/ (n): sàn đấu (boxing)


	- elect /ɪˈlekt/ (v): lựa chọn, bầu chọn
	- skateboard /ˈskeɪt.bɔːrd/: (n, v) ván trượt, trượt ván

	- equipment /ɪˈkwɪp mənt/ (n): thiết bị, dụng cụ
	- ski /ski/ (n, v): trượt tuyết, ván trượt tuyết

	- exhausted /ɪɡˈzɑː.stɪd/ (adj): mệt nhoài, 
	- water-skiing /ˈwɔ·t̬ər ˈskiː.ɪŋ/ (n): lướt ván nước

	- fencing /ˈfen·sɪŋ/ (n): đấu kiếm
	- weightlifting  /ˈweɪtˌlɪf·tɪŋ/ (n): cử tạ

	- fit /fɪt/ (adj): mạnh khỏe
	- windsurfing /ˈwɪndˌsɜr·fɪŋ/ (n): lướt ván buồm

	- goggles /ˈɡɑɡ·əlz/ (n): kính (để bơi)
	- gym /dʒɪm/ (n): trung tâm thể dục

	- horse race /hɔːrs ˈreɪs/ (n): đua ngựa
	

	- gymnastics /dʒɪmˈnæs·tɪks/ (n): thể dục dụng cụ
	



II/ Find one odd word for each question, and then read them aloud. 
1.	A. basketball	B.volleyball	C.football	D.chess
2.	A.marathon	B.running	C.swimming	D.high jump
3.	A. net	B.ball	C.racket	D.bicycle
4.	A.swimmer	B. gym	C.athlete	D.player
5.	A.sporty	B.play	C.hit	D.kick
III/ Choose the correct answers. 
1.	Nam plays sports very often, so he looks very		.
	A.sport	B.sports	C.sporty	D.sporting
2.	Team sports are sometimes called		sports.
	A.compete	B.competition	C.competitor	D.competitive
3.	Football is regarded		the most popular sport in the world.
	A.for	B.as	C.like	D.of
4.	I like watching football matches, but I am not very good		playing football.
	A.at	B.in	C.on	D.for
5.	In team sports, the two teams		against each other in order to get the better score.
	A. are	B.do	C.make	D.compete
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